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Features of AutoCAD® 2022 for Interior Design 
and Space Planning

This text uses the features of AutoCAD® 2022 in a variety of exercises specifically 
for interior design and architecture. Features include:

  1

• Describe the AutoCAD user interface and begin 
using parts of the screen.

• Modify and save a workspace.

chapterone

CHAPTER OBJECTIVES

Introduction
Before you start using the exercises in this book, you need to understand 
their structure and purpose. Throughout the exercises in this book:

• Numbered steps provide instructions.

• Prompt and Response columns within the numbered steps provide 
step-by-step instructions for starting and completing a command.

• The Prompt column text repeats the AutoCAD prompt that appears in 
the command line area of the AutoCAD screen.

• The Response column text shows your response to the AutoCAD prompt.

• Command grids in the margins and menu screens show you how to 
locate the command you are using.

1Introducing the AutoCAD 
User Interface

Chapter Objectives with a bulleted list of learning objec-
tives at the beginning of each chapter provide users with 
a roadmap to the commands, concepts, and practices to 
be introduced.

Because users need a lot of practice, Chapter 2, 
Quick-Start Tutorials, challenges the user to make 
2D drawings. These tutorials are designed with spe-
cial step-by-step instructions that will walk the 
reader through the entire development process 
while raising interest in mastering the content to 
come in the rest of the chapters.
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 Chapter 2 | Quick-Start Tutorials: Basic Settings and Commands 31

TUTORIAL 2-1
Part 1, Beginning an AutoCAD 
Drawing: Saving Your Work; Setting 
Units, Limits, Grid, and Snap; 
Creating Layers

Beginning an AutoCAD Drawing
When you click New… from the Quick Access Toolbar or New from the 
application menu button, or the New down arrow at the left side of the 
Start tab, AutoCAD allows you to select a template file from the Template 
folder or use the default template file. A template file has settings already 
established. These settings can include units, limits, grid, snap, and a 
border and title block. Templates save time because the settings are already 
made.

If you click New… and select the acad.dwt template, as shown in 
Figure 2-2, you are in the same drawing environment as when you simply 
open the AutoCAD program and begin drawing. AutoCAD uses the template 
acad.dwt for the drawing settings if no other template is selected.

You do not need to click New… from the File menu. You can stay in the 
drawing environment that appeared when you started AutoCAD.

NEW

Application 
Menu:

 New/
Drawing

Quick 
Access 
Toolbar:

Menu Bar: File/New

Type a 
Command: NEW

Figure 2-2
Select the acad.dwt template for a new drawing

The first appearance of each key term is bold 
and italic within the running text and accompa-
nied by a brief definition in the margin. The 
glossary at the end of the book contains a 
 complete list of the key terms and more detailed 
definitions to help students understand and use 
the language of the computer-aided drafting 
(CAD) world.

4 Part One | Preparing to Draw with AutoCAD

The real advantage is that each drawing that you open, whether from a 
tab or by using the Open command, has its own tab. Now switching among 
drawings is easy to do.

AutoCAD 2022 introduces Floating Drawing tabs. You can now drag a 
tab to an area outside AutoCAD’s application window and view two draw-
ings at the same time, without having to switch tabs and see them one at a 
time. The command line window and all other interface features are active 
in the floated window. To return a Floating Drawing tab to the application 
window, simply drag it next to another tab in the main window.

user interface: All the elements 
such as the AutoCAD screen that 
make up the interface between the 
user and the AutoCAD program.

OPTIONS

Ribbon/
Panel

View/
Interface/
Dialog Box 
Launcher

Menu Bar: Tools/ 
Options

Type a
Command: OPTIONS

Command
Alias: OP

Figure 1-3
List of available drawing 
templates in AutoCAD 2022

Drawing Window and Graphics Cursor
The AutoCAD user interface (Figure 1-4) contains the drawing window and 
access to commands. The drawing window is where your drawing is dis-
played. The graphics cursor (or crosshairs) follows the movement of a 
mouse when points of a drawing are entered or a command is selected. The 
box at the center of the crosshairs is called a pickbox.

Other components of the user interface, as shown in Figure 1-4, are

• Application Menu Button

• Quick Access Toolbar

• Share Drawing Button

• Infocenter

• Ribbon and its Tabs and Panels

• ViewCube

• Navigation Bar

Command Grids appear in the margin alongside 
the discussion of the command or the particular 
exercise in which it is demonstrated. These grids 
provide specific information about the ways of 
invoking each command, including any of the 
following:

• Ribbon panel
• Toolbar icon
• Pull-down menu
• Command line
• Command alias

4 Part One | Preparing to Draw with AutoCAD
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in the floated window. To return a Floating Drawing tab to the application 
window, simply drag it next to another tab in the main window.

user interface: All the elements 
such as the AutoCAD screen that 
make up the interface between the 
user and the AutoCAD program.

OPTIONS

Ribbon/
Panel

View/
Interface/
Dialog Box 
Launcher

Menu Bar: Tools/ 
Options

Type a
Command: OPTIONS

Command
Alias: OP

Figure 1-3
List of available drawing 
templates in AutoCAD 2022

Drawing Window and Graphics Cursor
The AutoCAD user interface (Figure 1-4) contains the drawing window and 
access to commands. The drawing window is where your drawing is dis-
played. The graphics cursor (or crosshairs) follows the movement of a 
mouse when points of a drawing are entered or a command is selected. The 
box at the center of the crosshairs is called a pickbox.
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Tip, Note, and For More Details boxes highlight 
additional helpful information for the student. 
Such information may contain dos and don’ts, 
facts, warnings, and alternative ways of pro-
ceeding, as well as cross-references to other 
chapters and topics.
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 Chapter 3 | Drawing with AutoCAD: Conference and Lecture Rooms 141

Path
The Path option of ARRAY allows you to make multiple copies of an object 
evenly distributed along a path or part of a path. The path can be a line, 
polyline, arc, circle, or ellipse.

ARRAYEDIT
An array must be associative, an option in the array commands, for the 
ARRAYEDIT command to work. When an array is associative, it is treated 
as a single object and you can edit it by using grips, Properties, or 
ARRAYEDIT.

TIP

Items can automatically be added to a path array when you lengthen the path using the 
Measure option of ARRAYEDIT.

 
NOTE

After an object has been selected, you can use the Array option of the COPY command 
to make multiple copies of the object.

 

Distance
You can use the Distance command to determine measurements.

Step 24. Use the Distance command to measure a specified distance 
(Figure 3-32), as described next:

Prompt Response

Type a command: Distance (or type DI <Enter>)
Specify first point: Osnap-Intersection
int of P3➔ (Figure 3-32)
Specify second point or 
 [Multiple points]: Osnap-Intersection
int of P4➔ (Figure 3-32)
Distance = 3′8″, Angle in 
 XY Plane = 0, Angle from 
 XY Plane = 0, Delta X = 3′-8″, 
 Delta Y = 0′-0″, Delta Z = 0′-0″

PATH ARRAY

Ribbon/
Panel

Home/
Modify

Modify
Toolbar:

Menu Bar: Modify/Array/
Path Array

Type a
Command: ARRAYPATH

ARRAYEDIT

Ribbon/
Panel

Home/
Modify 
(slideout)

Modify II 
Toolbar:

Menu Bar:
Modify/
Object/
Array

Type a
Command: ARRAYEDIT

DISTANCE

Ribbon/
Panel

Home/
Utilities

Inquiry
Toolbar:

Menu Bar:
Tools/
Inquiry/
Distance

Type a
Command: Distance

Command 
Alias: DI
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FOR MORE DETAILS
See Chapter 6 for more information about annotative text and Chapter 7 for more 
information about annotative dimensions.

Plot Offset (Origin Set to Printable Area)
Use the Plot offset area to center the plot on the paper, or specify specific 
horizontal and vertical distances from the lower-left corner of the paper.

Center the plot: To center the drawing on the paper, select the Center 
the plot check box; the plot will be automatically centered on the 
paper.

X and Y offset: The plot offset specifies the location of the plot, on the 
paper, from the lower-left corner of the paper. The X: input line moves 
the plotted drawing in the X direction on the paper, and the Y: input 
moves the drawing in the Y direction. You can enter either positive or 
negative values.

Step 12. Select the Center the plot check box.

Notice that the X and Y inputs are automatically calculated to center the 
selected plotting area (extents) in the paper size (8-1/2″ × 11″).

Shaded Viewport Options
The Shaded Viewport options relate to 3D drawings and control how 
shaded and rendered viewports are plotted. This process is described in 
Chapters 14 and 15.

Plot Options
Plot options and drawing orientation are visible when you click the More 
arrow at the bottom-right corner of the Plot dialog box.

Plot in background: A check mark in this box allows you to continue 
working while your drawing is being plotted.

Plot object lineweights: A check mark in this box tells AutoCAD to 
plot the drawing using the lineweights you have assigned to any object 
in the drawing.

Plot transparency: You can enter a transparency value in the Layer 
dialog box. It is a setting that makes an object more or less transpar-
ent. If you have transparent objects in your drawing, this option deter-
mines whether the transparency is plotted.

Plot with plot styles: This option allows you to use a plot style. 
Because you are not using a plot style, this box will not be checked.

Plot paperspace last: Selecting this option means that model space 
will be plotted first. Usually, paper space drawings are plotted before 
model space drawings.

End-of-Chapter material can easily be located by the 
shading on the page edges. This material will help 
students evaluate and practice the knowledge 
they’ve acquired about the most important concepts 
explained in the chapter. This material’s content 
includes:

• Chapter Summary
• Chapter Test Questions

• Multiple Choice
• Matching
• True or False
• List (Five different ways of executing commands 

in AutoCAD 2022)

26 Part One | Preparing to Draw with AutoCAD

chapterone1    Chapter Summary

This chapter described the AutoCAD user interface and gave you some 
experience with parts of the user interface. You will now be able to modify 
and save a workspace so you can begin drawing effectively.

Chapter Test Questions

Multiple Choice
Circle the correct answer.

 1. Which of the following is not one of the commands in the application 
menu?
a. Delete c. Close

b. Open d. Publish

 2. Which of the following is a ribbon panel?
a. Home c. Draw

b. File d. Save

 3. Which of the following icons on the Modify panel of the ribbon has a 
flyout?
a. Move c. Scale

b. Copy d. Trim

 4. Ribbon panels with a diagonal arrow in the lower-right corner display 
which of the following when you click the diagonal arrow?
a. Flyouts c. The Help menu
b. A dialog box or palette d. Options

 5. Which of the following displays the name of the command and gives 
other information relating to it?
a. Tooltips c. Dialog boxes
b. Flyouts d. Palettes

Matching
Write the number of the correct answer on the line.

a. Workspace Switching ______
b. Status Bar menu ______

c. Quick Access toolbar ______

d. Quick View Layouts and Drawings ______

e. Selection Cycling ______

1. Allows you to switch between defined workspaces
2. Allows you to preview and switch between lay-

outs and drawings
3. A menu that allows you to turn off and on the 

visibility of the buttons in the status bar
4. A means of choosing one object when two 

objects lie directly one on top of each other
5. Contains the New, Open, Save, Save As..., 

Open from Web & Mobile, Save to Web & 
Mobile, Plot, Undo, and Redo commands

Chapter Projects are additional assignments located 
at the end of each chapter in which students are 
directed to solve particular tasks on their own. The 
projects are labeled as basic, intermediate, and 
advanced according to the degree of complexity. 
Students will use the knowledge acquired through-
out the chapter as well as in previous chapters in 
completing these assignments.

170 Part Two | Two-Dimensional AutoCAD

chapterthree3    Chapter Projects

Project 3-1: Rectangular Lecture Room 
Including Furniture [BASIC]

 1. Draw the floor plan of the lecture room as shown in Figure 3-57. Use 
the dimensions shown in Figure 3-58, or use an architectural scale to 
measure the floor plan and draw it full scale.

 2. Use the Single Line Text command to type your name, class number, 
and date, 6″ high in the upper-right corner (Figure 3-57).

Figure 3-57
Project 3-1: Rectangular lec-
ture room including furni-
ture (scale: 1/4″ = 1′-0″)

New to AutoCAD® 2022 icons indicate the commands 
and tools that are new to this specific release of the 
program. This feature allows instructors and other users 
to quickly identify topics that are completely new, sav-
ing them a good amount of research time. It also dem-
onstrates to students the recent improvements to the 
AutoCAD software, as well as the valuable updated 
information contained in this textbook. This book uses 
many of the features new to the software since the pre-
vious release of this book for AutoCAD 2015.

2 Part One | Preparing to Draw with AutoCAD

EXERCISE 1-1
Examine the AutoCAD User Interface 
and Save a Workspace
Launching AutoCAD 2022 displays the interface shown in Figure 1-1, with 
the Start tab and a drawing tab labeled Drawing1. The presence of the 
Start tab is controlled by the STARTMODE system variable. By default, 
the Start tab is visible and remains open as drawing files are opened. The 
revised Start tab contains three areas.

On the left side area you can Open an existing drawing or create a New 
drawing. The display in the center and right areas changes depending on 
your choice of Recent, Autodesk Docs, or Learning. Below those three 
options are six links to different options and applications:

• What’s new: Displays links to new features in AutoCAD 2022 in a new 
browser window

• Online help: Opens AutoCAD 2022 Help in a browser window

• Community forum: Opens the main page for all AutoCAD forums of the 
Autodesk Knowledge Network in a browser window

• Customer support: Opens the Support & Learning page of the Autodesk 
Knowledge Network in a browser window

• AutoCAD mobile app: The AutoCAD mobile app is a paid subscription 
available from Google Play and Apple’s App Store

• AutoCAD web app: If you have an Autodesk account, you can run all 
tools and commands in a web browser.

By default, Recent in the left side of the Start tab is selected. The 
center area of the tab displays a list of recently open drawings, and the 
right side shows Announcements from Autodesk. Clicking a filename or 
icon in the center area opens the drawing on its own file tab.

The area on the right is visible only when the Recent option on the left 
is selected. In it, you see Announcements and “Have you tried…” items.

Autodesk Docs is a file management system that requires a subscrip-
tion to AutoCAD. It links to a system of virtual drives connected through 
the cloud. Autodesk Docs is primarily intended as a way for teams remote 
from one another to connect remotely. This option is not covered in this 
book.

Clicking Learning on the left side of the Start tab displays links to 
specific tips to learning and using AutoCAD, to a series of videos showing 
program operation, and to a series of free online learning resources (see 
Figure 1-2).

Clicking New at the left side of the Start tab prompts you to select 
from a series of drawing template files to begin your new drawing. 
Figure 1-3 shows the list of available drawing templates. The last template 
used becomes the default template.

NEW to

AutoCAD

2022
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Preface

AutoCAD has become the industry-standard graphics program for interior 
design and space planning. This program is used to complete the many 
contract documents (CDs) that make up a design project. Many design 
firms have adopted AutoCAD as their standard because:

•	 It saves time.

•	 Affiliated professions have chosen it so that they can exchange files and 
work on the same drawing.

•	 Their competitors use it.

•	 Their clients expect it.

To be successful in design today, students must be proficient in the 
use of AutoCAD as it relates to interior design and space planning. The 
need for an AutoCAD textbook geared specifically to this field is what led us 
to write AutoCAD® 2022 for Interior Design and Space Planning.

This text, newly updated for AutoCAD® 2022, is divided into three 
parts:

•	 Part I: Preparing to Draw with AutoCAD (Chapter 1).

•	 Part II: Two-Dimensional AutoCAD (Chapters 2–13).

•	 Part III: Three-Dimensional AutoCAD (Chapters 14–15).

This new edition includes many features designed to help you master 
AutoCAD® 2022:

•	 The prompt-response format is clearly defined with numbered steps. This 
step-by-step approach is used in the beginning exercises of all chapters 
and then moves to an outline form in projects at the end of most chap-
ters. This allows students to learn commands in a drawing situation and 
then practice applying them on their own.

•	 Lineweights have been carefully assigned to provide line contrast in all 
drawing exercises.

•	 Plotting is used in Chapter 2 to allow students to plot their first 
drawings.

•	 Chapter 7 covers updated ways to change dimension variables, as well as 
the recently introduced DIM command. 

•	 Chapter 9 updates the process of finding and inserting blocks using the 
BLOCKS palette.

•	 Chapter 15 updates the sections on adding lights and rendering models.

•	 Exercises are geared to architects, interior designers, and space plan-
ners, allowing students to work with real-world situations.

•	 More than 600 illustrations (many printed to scale) support the text and 
reinforce the material.

•	 Screen shots and command grids help the user locate AutoCAD 
commands within the AutoCAD menus and ribbon.
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•	 “Tip,” “Note,” and “For More Details” boxes give students additional 
support and information.

•	 Practice projects at the end of every chapter review the commands 
learned.

•	 Learning objectives and review questions in every chapter reinforce the 
learning process.

•	 An online Instructor’s Manual is available to support the text.

Organized around architectural and interior design–related projects, 
AutoCAD® 2022 for Interior Design and Space Planning gives students an 
understanding of the commands and features of AutoCAD® 2022 and dem-
onstrates how to use the program to complete interior design and space 
planning projects. The book is appropriate for self-paced and lecture 
classes and covers both two-dimensional and three-dimensional drawings.

Throughout the exercises in this book, steps numbered in color provide 
instructions. Prompt and Response columns in the numbered steps pro-
vide step-by-step instructions for starting and completing a command. The 
Prompt column text repeats the AutoCAD prompt that appears in the com-
mand area of the AutoCAD screen. The Response column text shows how 
you should respond to the AutoCAD prompt. Screen shots of menus and 
command grids show you how to locate the command you are using.

Using numerous illustrations, the text captures the essence of this 
powerful program and the importance it plays in the interior design, archi-
tecture, and space planning professions.

Most importantly, this text was written to help you, the reader, master 
the AutoCAD program, which will be a valuable tool in your professional 
career.

Hallmark Features
Progresses from Basic Commands to Complex 
Drawing Exercises

•	 Builds confidence and basic skills before moving on to more complex 
assignments.

•	 Ensures students have mastered the fundamental features and 
commands of the AutoCAD program before they apply it to more complex 
problems.

•	 Guides readers step-by-step through each new AutoCAD command.

•	 Encourages students to learn commands and features on their own.

Provides More Than 100 Exercises and Projects

•	 Gives students the opportunity to work with a variety of real-world 
situations, including both commercial and residential projects.
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Highlights Projects Appropriate for Interior Design, Space 
Planning, and Architecture Students

•	 Projects are a tenant space, hotel room, and wheelchair-accessible com-
mercial restroom.

•	 Includes project floor plans, dimension plans, elevations, furniture plans, 
reflected ceiling plans, and voice/data/power plans, as well as isometric 
drawings, a presentation sheet, and the sheet set command that com-
bines multiple plans.

Includes More Than 600 Figures

•	 Helps students by allowing them to compare their work and progress 
with the many figures available.

•	 Shows many drawings to scale so students can assess and check their 
understanding of chapter material.

The AutoCAD DesignCenter

•	 The DesignCenter is used to import blocks, layers, and dimension styles 
from other drawings into existing drawings.

Covers Solid Modeling in Two Chapters

•	 Splits solid modeling material into two chapters: Chapter 14, Solid 
Modeling; and Chapter 15, Advanced Modeling.

•	 Uses the 3DWALK and Animation Motion commands to create walk-
through presentations.

New to This 2022 Edition

•	 Revised Start Tab

•	 Floating drawing tabs

•	 Commands introduced in all areas of the program since the previous 
edition

•	 Enhanced Help (to locate tools in AutoCAD)

•	 (View) Ribbon Enhancements

Instructor Resources
The Online Instructor’s Manual provides answers to unit exercises and 
tests, solutions to end-of-chapter questions, and lecture-supporting 
PowerPoint® slides.

Instructor materials are available from Pearson’s Instructor Resource 
Center. Go to https://www.pearson.com/us/higher-education/ 
subjectcatalog/download-instructor-resources.html to register, or  
to sign in if you already have an account.
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Style Conventions in AutoCAD® 2022 for Interior Design 
and Space Planning

Text Element Example

Key Terms—Boldface and italic on first mention 
(first letter lowercase, as it appears in the body of 
the text). Brief definition in margin alongside first 
mention. Full definition in Glossary at back of 
book.

Views are created by placing viewport 
objects in the paper space layout.

AutoCAD commands—Bold and uppercase. Start the LINE command.

Ribbon and panel names, palette names, 
toolbar names, menu items, and dialog box 
names—Bold and follow capitalization conven-
tion in AutoCAD toolbar or pull-down menu  
(generally first letter cap).

The Layer Properties Manager palette

The File menu

Panel tools, toolbar buttons, and dialog box 
controls/buttons/input items—Bold and follow 
the name of the item or the name shown in the 
AutoCAD tooltip.

Choose the Line tool from the Draw panel.

Choose the Symbols and Arrows tab in the 
Modify Dimension Style dialog box.

Choose the New Layer button in the Layer 
Properties Manager palette.

In the Lines and Arrows tab, set the Arrow 
size: to .125.

AutoCAD prompts—Dynamic input prompts are 
set in a different font to distinguish them from 
the text. Command window prompts are set to 
look like the text in the command window, 
including capitalization, brackets, and punctua-
tion. Text following the colon of the prompts 
specifies user input in bold.

AutoCAD prompts you to Specify first point: 
Specify center point for circle or [3P 2P Ttr 
(tan radius)]: 3.5

Keyboard Input—Bold with special keys in 
brackets.

Type 3.5 <Enter>

Register Your Book
Register your copy of AutoCAD 2022 for Interior Design and Space Planning 
on the InformIT site for convenient access to updates and/or corrections as 
they become available. To start the registration process, go to informit.com/
register and log in or create an account. Enter the product ISBN 
(9780136787884) and click Submit. Look on the Registered Products tab 
for an Access Bonus Content link next to this product, and follow that link 
to access any available bonus materials. If you would like to be notified of 
exclusive offers on new editions and updates, please check the box to 
receive email from us. 

viii	 Preface
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	�  1

•	 Describe the AutoCAD user interface and begin 
using parts of the screen.

•	 Modify and save a workspace.

chapterone

CHAPTER OBJECTIVES

Introduction
Before you start using the exercises in this book, you need to understand 
their structure and purpose. Throughout the exercises in this book:

•	 Numbered steps provide instructions.

•	 Prompt and Response columns within the numbered steps provide  
step-by-step instructions for starting and completing a command.

•	 The Prompt column text repeats the AutoCAD prompt that appears in 
the command line area of the AutoCAD screen.

•	 The Response column text shows your response to the AutoCAD prompt.

•	 Command grids in the margins and menu screens show you how to 
locate the command you are using.

1Introducing the AutoCAD 
User Interface
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2	 Part One  |  Preparing to Draw with AutoCAD

EXERCISE 1-1
Examine the AutoCAD User Interface 
and Save a Workspace
Launching AutoCAD 2022 displays the interface shown in Figure 1-1, with 
the Start tab and a drawing tab labeled Drawing1. The presence of the 
Start tab is controlled by the STARTMODE system variable. By default,  
the Start tab is visible and remains open as drawing files are opened. The 
revised Start tab contains three areas.

On the left side area you can Open an existing drawing or create a New 
drawing. The display in the center and right areas changes depending on 
your choice of Recent, Autodesk Docs, or Learning. Below those three 
options are six links to different options and applications:

•	 What’s new: Displays links to new features in AutoCAD 2022 in a new 
browser window

•	 Online help: Opens AutoCAD 2022 Help in a browser window

•	 Community forum: Opens the main page for all AutoCAD forums of the 
Autodesk Knowledge Network in a browser window

•	 Customer support: Opens the Support & Learning page of the Autodesk 
Knowledge Network in a browser window

•	 AutoCAD mobile app: The AutoCAD mobile app is a paid subscription 
available from Google Play and Apple’s App Store

•	 AutoCAD web app: If you have an Autodesk account, you can run all 
tools and commands in a web browser.

By default, Recent in the left side of the Start tab is selected. The 
center area of the tab displays a list of recently open drawings, and the 
right side shows Announcements from Autodesk. Clicking a filename or 
icon in the center area opens the drawing on its own file tab.

The area on the right is visible only when the Recent option on the left 
is selected. In it, you see Announcements and “Have you tried…” items.

Autodesk Docs is a file management system that requires a subscrip-
tion to AutoCAD. It links to a system of virtual drives connected through 
the cloud. Autodesk Docs is primarily intended as a way for teams remote 
from one another to connect remotely. This option is not covered in this 
book.

Clicking Learning on the left side of the Start tab displays links to  
specific tips to learning and using AutoCAD, to a series of videos showing 
program operation, and to a series of free online learning resources (see 
Figure 1-2).

Clicking New at the left side of the Start tab prompts you to select 
from a series of drawing template files to begin your new drawing.  
Figure 1-3 shows the list of available drawing templates. The last template 
used becomes the default template.

NEW to

AutoCAD

2022
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	 Chapter 1  |  Introducing the AutoCAD User Interface� 3

Figure 1-1
The Start tab of AutoCAD 2022 showing recently opened files in the center area

Figure 1-2
Click Learning on the Start tab to display aids to learning AutoCAD
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4	 Part One  |  Preparing to Draw with AutoCAD

The real advantage is that each drawing that you open, whether from a 
tab or by using the Open command, has its own tab. Now switching among 
drawings is easy to do.

AutoCAD 2022 introduces Floating Drawing tabs. You can now drag a 
tab to an area outside AutoCAD’s application window and view two draw-
ings at the same time, without having to switch tabs and see them one at a 
time. The command line window and all other interface features are active 
in the floated window. To return a Floating Drawing tab to the application 
window, simply drag it next to another tab in the main window.

user interface:  All the elements 
such as the AutoCAD screen that 
make up the interface between the 
user and the AutoCAD program.

OPTIONS

Ribbon/
Panel

View/
Interface/
Dialog Box 
Launcher

Menu Bar: Tools/
Options

Type a
Command: OPTIONS

Command
Alias: OP

Figure 1-3
List of available drawing 
templates in AutoCAD 2022

Drawing Window and Graphics Cursor
The AutoCAD user interface (Figure 1-4) contains the drawing window and 
access to commands. The drawing window is where your drawing is dis-
played. The graphics cursor (or crosshairs) follows the movement of a 
mouse when points of a drawing are entered or a command is selected. The 
box at the center of the crosshairs is called a pickbox.

Other components of the user interface, as shown in Figure 1-4, are

•	 Application Menu Button

•	 Quick Access Toolbar

•	 Share Drawing Button

•	 Infocenter

•	 Ribbon and its Tabs and Panels

•	 ViewCube

•	 Navigation Bar
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	 Chapter 1  |  Introducing the AutoCAD User Interface� 5

•	 User Coordinate System Icon

•	 Status Bar

•	 Command Line

The size of the graphics cursor and pickbox can be changed to accom-
modate individual preferences. The colors of the elements in the drawing 
window also can be changed.

Information regarding commands is attached to the cursor. This can be 
turned on or off using the DYNMODE toggle in the status bar, as described 
later in this chapter.

Step 1.	 Locate the Options dialog box, where you can change the size of 
the graphics cursor, the colors of the elements in the drawing win-
dow, and the pickbox, as described next.

Application
Menu Button

Quick Access
Toolbar

Drawing Tab

Panel

Graphics Cursor
(Crosshairs)

Navigation Bar

ViewCube

User Coordinate
System (UCS) Icon

Model & Layout Tabs
Status Bar

Command
Line Window

Drawing Area

Share Ribbon Tab Infocenter

Ribbon
Ribbon

Figure 1-4
The AutoCAD user interface
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6	 Part One  |  Preparing to Draw with AutoCAD

Prompt	 Response

Type a command:	� Type OP <Enter> (in this book,  
 � <Enter> means to press the 

<Enter> key or press the right 
mouse button to enter a command)

The Options dialog box appears	 Click the Display tab
The Display tab appears	  
  (Figure 1-5):	� Click the Crosshair size slider in  

 � the lower right to decrease or 
increase the size of the crosshairs

	 Click the Colors... button on the left
The Drawing Window Colors  
  dialog box (Figure 1-6) appears:	� This is where you can change  

 � colors of the elements in the 
drawing window

	� Click Cancel to exit the Drawing  
  Window Colors dialog box

	 Click the Selection tab
The Selection tab appears:	� Click the Pickbox size slider in the  

 � upper left to decrease or increase 
the size of the pickbox

	� Click Cancel to exit the Options  
  dialog box

Figure 1-5
Options dialog box—Display tab
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Figure 1-6
Drawing Window Colors dialog box

Application Menu Button
When you click (quickly press and release the left mouse button) on the 
Application menu button, the application menu opens. The application 
menu commands (Figure 1-7) can be used to

•	 Create a new drawing

•	 Open an existing drawing

•	 Save a drawing

•	 Save a drawing as another format

•	 Import a PDF, Microstation DGN drawing, or numerous other file formats

•	 Export your drawing to a different format

•	 Publish or share a drawing

•	 Print or plot a drawing

•	 Access tools to maintain your drawing

•	 Close a drawing

At the top of the application menu, you can enter key words in the text 
box to search for additional menu items.
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Step 2. Click the application menu button with your left mouse button to 
open it. Hold your cursor over each command to see the brief 
descriptions of the command options. Press the <Esc> key to exit 
the application menu (Figure 1-7).

Figure 1-7
Application menu

Inputting or Selecting a Command
AutoCAD provides four major ways to input or select a command:

1 Select a command icon from the ribbon.

2 Type a full command name or command alias (for example, L for line) 
at the command line window.

3 Use the Quick Access toolbar customization button to show the menu 
bar. You can then select an icon/command from the menu bar.

4 Use the Tools menu on the menu bar to access the AutoCAD toolbars. 
You can then select a command icon from a toolbar.

Ribbon
The ribbon displays the commands used to make a drawing. If you right-
click (quickly press and release the right mouse button) on any menu tab, 
you will get a right-click menu (Figure 1-8) that has commands to hide or 

1 1 

2 2 

3 3 

4 4 

ribbon: The user interface below 
the Quick Access toolbar that com-
prises tabs and panels with 
flyouts used to access the commands 
for both 2D drawing and annotation 
and 3D modeling, viewing, and 
rendering.

command line window: The text 
area above the status bar used for 
keyboard input and prompts, and 
where AutoCAD displays messages.

menu bar: The bar containing 
menus displayed using the Quick 
Access toolbar customization 
button; contains commonly used 
commands.

toolbar: A graphical interface 
containing icons that represent 
commands.
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show tabs, panels, and panel titles. This right-click menu also has  
commands to close the ribbon or undock it. If you close the ribbon, type 
RIBBON <Enter> at the command prompt to reopen it.

Figure 1-8
Display the right-click  
menu by right-clicking on  
a ribbon tab

When you undock the ribbon, you can drag it to display as horizontal, 
vertical, or floating.

You can also drag individual panels of the ribbon into your drawing 
window and float them. You can drag them back into the ribbon, or you 
can click on Return Panels to Ribbon in the upper-right corner grab bar 
(Figure 1-9) to return the panel to the ribbon.

Step 3.	 Click each menu tab—Home, Insert, Annotate, Parametric, 
View, Manage, Output, and Express Tools—in the ribbon to view 
the commands available.

Expanded Panels
Panels with an arrow to the immediate right of the panel title can be 
expanded to display additional commands. When you left-click on the 
arrow, the panel will expand. When the panel is expanded, you can use the 
pushpin icon to the left of the panel title to keep the panel expanded  
(Figure 1-10). A few panels also display a down-to-the-right arrow at the 
far-right end of the panel label. This arrow is called the Dialog Box 
Launcher. Click the arrow to display the appropriate dialog box.

Figure 1-9
Return Panels to Ribbon option in the 
upper right corner of a floating panel

Figure 1-10
Expanded panel

Dialog Boxes and Palettes
Panels with a diagonal arrow in the lower-right corner of the panel title can 
open dialog boxes or palettes. When you left-click on the diagonal arrow, a 
dialog box or palette appears, as shown in Figure 1-11.
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